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ABLE2EXTRACT PROFESSIONAL 20 

Converting, creating, editing, compressing, and repairing PDFs has never been easier! 

When it comes to working with PDF files, there’s no substitute for an all-in-one PDF converter. 

It’s an essential tool in any business environment, streamlining and accelerating the process of 

managing data in the most widely used digital file format for sharing and archiving documents. 

Able2Extract Professional 20 offers everything you need to handle every PDF task with ease. 

The latest version comes with major enhancements, making it the ultimate PDF converter for 

both individuals and businesses. 

 

New Features in Able2Extract Pro 20 

● Automatically Repair Damaged PDF Files    
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This latest version has your PDF document top of mind! You can now quickly restore damaged 

PDFs with our brand new built-in PDF repair tool. Designed to handle a range of issues, the PDF 

repair tool can automatically scan your file to detect and fix the most common PDF issues. 

Able2Extract Pro lets you work seamlessly with problematic PDFs, ensuring you can accomplish 

any PDF task needed.   

● Custom Compress Your Large PDFs  

Able2Extract Professional 20 is built to keep your workflow with large PDFs seamless. With this 

latest version, you can now compress the file size of any opened PDF. Gain control over the PDF 

resizing process and specify which elements to adjust. Compress bitmaps, subset fonts, and 

remove annotations or file attachments. Tailor your compression, keep what you want intact, 

and reduce your PDF file - all at once!    

● Convert Table Row Data with More Precision 

 

For this latest version, we’ve improved the PDF to Excel conversion to ensure your data 

extractions are more accurate than ever. Able2Extract Pro 20 is enhanced with better row 

separation recognition that provides you with better output, allowing you to place several rows 

of text into one single row. Experience more flexible and powerful conversions for invoices, 

records, and line items more precisely in formatted Excel spreadsheets.   

● Extract PDF Form Values Accurately to Excel    

Another new update we’ve worked on is the ability to extract and transfer your PDF form data 

directly into Excel. That’s right! You can now retain and work with the original text style – font 

and text color – of your extracted form data in an editable spreadsheet.  With Able2Extract 

Professional 20, you’ll be able to convert your collected form data and analyze it with ease. 

● Effortlessly Merge and Convert Non-PDF Files 

In addition to merging PDFs, you can now combine various file types, such as Word, Excel, 

PowerPoint, and images, into a single PDF. Plus, easily batch upload and convert non-PDF files, 

including XLSX and PPTX, to any supported output format like Microsoft Word, providing more 

flexibility and efficiency in handling your digital documents. 
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● Simplified Installation and Support For macOS 

On top of product improvements, we’ve also provided a more simplified installation process for 

macOS users. The macOS version is an app trusted by Apple, ensuring that you can install 

Able2Extract Professional 20 on macOS 11 and higher. It can be installed on ARM or non-ARM 

(Intel) machines without issue. Just drag and drop to start the installation process and you’re all 

set to work on PDFs directly on your macOS desktop!   

● Performance Enhancements, Bug Fixes, and Support Coverage 

 

Version 20 includes critical bug fixes, important performance updates, and fully renewed 

support coverage for a smoother, more reliable user experience. You can expect optimized 

performance and consistent document output without compromising your workflow. 

How to Install Able2Extract Pro 20 

Able2Extract Professional 20 can be downloaded here: 

https://www.investintech.com/prod_downloadsa2e.htm 

Users will be presented with the download for their operating system. Alternatively, they can 

click the “Available for” icon to download installation(s) for Windows, Mac, or Linux (Fedora 

and Ubuntu) manually. 

The free trial version can be used for 7 days, and it allows users to use all Able2Extract 

Professional 20 features, with the only limitation of being able to convert up to three pages of a 

document. 

To continue using Able2Extract Professional 20 after the trial period has expired (or remove the 

trial’s three-page conversion limitation) users can purchase a full, lifetime license or a 30-day 

license here: https://www.investintech.com/order_a2e.htm 

For any help with installing and using the software, please get in touch with our support team 
using the contact information at the end of this document. 

https://www.investintech.com/prod_downloadsa2e.htm
https://www.investintech.com/order_a2e.htm
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System Requirements 

General Requirements 

● Administrative privileges for software installation 

● Internet connection may be required to download additional resources 

Detailed Hardware Requirements 

● Processor: 

o The processor must be x86 architecture. Both 32-bit or 64-bit are supported. 

● Memory: 

o 1+ GB of free memory available for the software 

● Disk space: 

o Windows: 400 MB 

o Mac: 400 MB 

o Linux: 400 MB (Ubuntu), 400 MB (Fedora) 

● Monitor: 

o Windows and Linux: 1366 (Width) x 768 (Height) screen resolution (higher 

resolution screen required if OS scaling is more than 100%) 

o Mac: 1366 (Width) x 768 (Height) or 1280 (Width) x 800 (Height) non-Retina 

screen resolution, 2560 (Width) x 1600 (Height) Retina screen resolution 

o 16bit (HighColor) or 24/32bit (TrueColor) color 

Compatible Operating Systems 

● Windows 11/10, Windows Server 2025/2022/2019/2016, 64-bit edition 

● macOS 15 (Sonoma), 13 (Ventura), 12 (Monterey), 11 (Big Sur) 

● Ubuntu 23.10, 23.04, 22.04, 20.04 

● Fedora 39, 38, 37, 36, 35, 64-bit edition 
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Able2Extract Pro 20 Functionalities 

User Interface 

Able2Extract Professional’s graphic user interface is unique in its simplicity without sacrificing 

functionality. A modern and straightforward design allows both professional and amateur users 

to easily navigate its Tabs, Main toolbar, and Side panel options. Users can choose between six 

UI languages (English, Spanish, German, French, Italian and Portuguese), Light and Dark theme, 

as well as decide if they would like to start every session with the help of the Start page or not. 

 

PDF tasks can be performed via the Main toolbar options (nested under eight distinct Tabs) by 

clicking on the appropriate icons. Multiple PDF documents can be opened in Able2Extract with 

each document opening in a separate tab, so users can switch between tabs and work on their 

files simultaneously. 
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Powerful PDF Conversion Features 

The starting point of any PDF conversion in Able2Extract Professional 20 is the Convert tab. It 

offers users the range of choices for converting their digital documents. To open the document 

that needs conversion, click on the Open icon. Exploring the Convert tab, users will find the 

following options: 

 

The whole document is selected for conversion by default. To convert just the part of a PDF or 

specific pages (page ranges), users can drag-select the content or use Selection options located 

in the Side panel. 

 

Multiple PDF Conversion Options 

Able2Extract Professional users can convert their PDF files into several different file formats: 

MS Excel, Word, PowerPoint, Publisher, OpenOffice (Calc, Write, and Impress), HTML, 

AutoCAD (DWG and DXF), CSV, Image formats (JPG, GIF, PNG, BMP, TIFF, WebP), and plain 

text. 

The conversion process is quick and straightforward. After opening the file for conversion, users 

can choose their preferred output format from the Convert tab’s Main toolbar right away to 

convert the whole document. 

Alternatively, they can drag-select the content for conversion, use selection options, and apply 

advanced settings from the Side panel before choosing the output file format. 
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Some conversions are automatic, such as PDF to Word and PDF to PowerPoint. Conversions 

such as PDF to Excel or PDF to CSV offer users a chance to customize their files prior to 

conversion. 
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Smooth and Accurate PDF Conversion 

Able2Extract Professional’s major strength is the accuracy of its conversion output, especially 

for complex conversions such as PDF to Excel and scanned (image) document conversion. These 

types of conversions have been difficult to perform with complete accuracy in the past. Based 

on MS Excel user complaints of PDF conversion software in general, Investintech.com has been 

improving Able2Extract Professional’s Custom PDF to Excel feature in every version of the 

software. The latest version 20 includes several PDF to Excel conversion enhancements, such as 

improvements with PDF table conversions, preserving cell wrapping formatting and 

performance optimizations when working with large PDFs. In addition, users can now double 

click to delete lines or tables in the Custom Excel tab. 

Able2Extract Professional 20 now offers even smoother and more accurate conversions, making 

this the most attractive feature for its users. 

Convert Almost Any Format to Excel 

As part of its offerings as a data extraction tool, Able2Extract Professional 20 can perform non-

PDF conversions directly into Excel spreadsheets. Users can easily transfer text and content 

from Word, PowerPoint, and more, into spreadsheets they can then instantly analyze. 

The conversion process is the same: users open their file (select the content to convert or 

proceed to convert the whole document) and simply select the PDF to Excel conversion 

command. 
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PDF to Excel Conversion Settings 

Able2Extract Professional 20 comes with the ability to refine conversion output results to 

Excel. The Advanced Analysis option improves upon Able2Extract’s ability to recognize PDF 

tables and transfer them into Excel. Users can select from different conversion settings that will 

further tweak the conversion process. 
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These settings can be accessed by clicking on the gear icon in the Convert to Excel dialog once 

you select Excel as your conversion output: 

 

Easy PDF Creation 

Able2Extract Professional 20 also includes PDF creation features.  

Users who wish to create PDFs within Able2Extract can go to the File tab and click on the Create 

PDF icon on the Main toolbar. 

 

Creating Secure PDFs 

Able2Extract Professional 20’s Create PDF function allows users to secure their file by 

password-protecting it and setting up various file permissions. 

Users can choose to set up permissions for printing, copying, modifying, adding comments, 

allowing only low-quality printing, etc. That way they can limit the recipients’ options when 
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dealing with their document. 

To access these settings, users need to click the PDF Creation Options icon under the File tab. 

 

This is an especially useful feature for creating professional documents that contain sensitive 

information. ￼ 

Complete Set of PDF Editing Features 

Able2Extract Professional 20 users can make changes to their PDF’s document information, 

viewing preferences, pages, content (text and images), and more. By simply clicking on the Edit 

Document tab, users can access PDF editing options and start further tailoring their documents. 
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Document Properties 

Users can edit document information (Title, Author, Subject and Keywords) as well as viewer 

preferences (hide toolbar and menubar, page mode and layout, open the document at a 

specific page and in a custom zoom mode, and more) by clicking on the Document Properties 

icon. 

 

Page Editing 

There are several page editing options to choose from in Able2Extract Professional 20: Merge, 

Split, Delete, Move, Resize, Rotate pages. Users can also Insert blank pages and undo or redo 

the last page editing operation in a PDF. 
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Users can also access PDF page editing through the right-click context menu in the Thumbnails 

panel on the left side of the interface. 

 

Text Editing 

Able2Extract Professional 20’s capabilities include on-page PDF text editing. Users can modify 

text and blocks of text directly in Able2Extract Professional. To add a new text block, click on 

the Add Text icon in the Main toolbar. 
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By using the Side panel options under the Properties section, users can specify the font style, 

adjust the font size, and change the text color and outline. When editing blocks of text or 

multiline text objects, users can also adjust the alignment, line spacing, and rotation. 

 

Adding Bitmap Images and Vector Graphics (Shapes) 

Able2Extract allows users to add their own bitmap images (JPG, BMP, PNG, TIFF, and GIF) from 

their computer to existing PDF content – perfect for personalizing or editing material for 

publication. 

 

Able2Extract Professional provides users with a selection of 12 customizable vector shapes 
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they can insert to visually boost their content: 

 

Redaction 

Users can selectively and permanently delete any sensitive information from the PDF 

document. Able2Extract Pro 20 is capable of redacting individual sections, lines and entire page 

content.  

 

Insert Bates Numbering 

Users needing to index PDF pages for easy reference can select from several options to create 

and insert customized Bates numbering to their PDF pages. Users can include personalized text 

and properly formatted date, pagination, and counter numbers. It is also possible to format the 

font, position, and page range to match the look and feel of the PDF itself. 

Click on the Add Bates Numbering icon to access the dialog window. To delete already applied 

Bates stamps, click on the Remove Bates Numbering icon. 
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Total Annotation Options Pack 

The PDF annotation feature allows users to create and insert annotations on their PDF. In 

addition, they can interact, review and post replies to existing comments and annotations.  

Users can digitally add Sticky Notes, Links, Stamps, Highlights, Underlines, Squiggly Lines, 

Strikethroughs, Carets, Attachments, and Watermarks by selecting the corresponding icons 

under the Review tab: 
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Sign and Secure PDFs Like a Pro 

Able2Extract Professional 20 lets users insert electronic and digital (cryptographic) signatures 

to PDFs in just a few clicks. Furthermore, Able2Extract can verify the authenticity of signed 

documents. 

By implementing digital signatures, users can save time and money on printing, signing, 

scanning, and sending paper files, maintain data integrity, and add a few extra layers of security 

to important PDF documents. 
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The latest version 20 goes above and beyond to let users apply digital signatures to multiple 

pages at once. This new feature could especially come in handy when working with large 

documents consisting of several pages. To insert a signature to multiple pages, users just need 

to set a page range and Able2Extract Professional will add the signature to the pages instantly.  

In addition to these PDF signing features, users can encrypt or decrypt existing PDF documents 

depending on the state of the opened PDF file. 

 

They can set passwords and file permissions as needed. For instance, users can open a PDF, 

make revisions or last-minute redactions, and then encrypt the document for secure sharing 

with third parties. 

These features are available in the Sign and Secure tab.  
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All-in-one PDF Forms Tool 

With Able2Extract’s PDF form filler, users can work with PDF forms directly in the application – 

complete digital forms without having to print, manually fill in, and then rescan forms back in 

again. PDF forms editor allows users to create PDF forms from scratch, edit existing ones, and 

control PDF form field placement. Align and center form fields with pinpoint precision so your 

business PDF forms are perfectly formatted every single time. 

Filling PDF Forms 

To start filling PDF forms in Able2Extract, users simply open the PDF form in the application and 

start entering data by clicking on the form (File, Sign and Secure, or Help tab must be active to 

activate the PDF form filling feature). 

They can type in text fields, click on the radio buttons or checkboxes, and select items from 

both list and combo boxes. Even push buttons are fully functional in Able2Extract. Users have 

the option of saving half-filled PDF forms or submitting a completed form back to servers. 

Editing and Creating PDF Forms 

Editing and creating PDF forms is just as easy. When in the Edit Form tab, users can insert a 

form field by clicking on the icon in the Main toolbar and then clicking onto the page where 

they wish to place it. Form fields can be customized, populated, and assigned values. To create 

PDF forms for submission, users need to set up a server to collect the data. Submission settings 

can be specified when the Push button is added to the form. 

 

Layout and Properties sections in the Side panel offer advanced options and additional 
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properties for customizing PDF forms. 

 

Exporting PDF Forms Data to CSV 

Able2Extract Professional 20 comes with a new extraction functionality that allows users to 

quickly and easily export essential PDF form data into a CSV file. 
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Document Comparison Tool 

With the Document comparison tool, users can open and compare any two printable 

documents side-by-side. The comparison tool highlights all differences between the 

documents, enabling users to quickly locate and examine all changes in the documents and 

avoid the tiresome process of comparing them line by line. 

 

Users can use the tools from the Compare toolbar to navigate around specific pages with 

differences, copy differences from one document to another, annotate all differences in one 

document or another, and save the changes in one document or another.  There is also a handy 

context menu that shows up once the user hovers over a certain highlighted difference, 

allowing them to copy, highlight, delete, and save the highlighted difference.  
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Advanced PDF Features 

Able2Extract Professional comes with a set of advanced features that separates it from other 

PDF tools. They have been developed and are being constantly improved to provide users with 

powerful ways to boost productivity and save time & money. 

Custom PDF to Excel Conversion  

Able2Extract Professional 20 offers advanced PDF to Excel conversion options to MS Excel 

users, allowing them to manually specify the column and row structure within their PDF 

spreadsheet and preview the PDF to Excel results prior to starting the conversion. 

Being such an important and powerful feature, it has a separate Custom Excel tab. 
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There are several options for Excel users that help them customize their file and avoid column 

misalignment within the table. They can: add, delete and replot tables, manage named table 

structures, add columns and erase column lines, manually edit rows, etc. 

Able2Extract users can enhance PDF to Excel conversions even more with AI-powered 

templates. Custom Excel templates can be trained to automatically locate and convert PDF 

tables that match the table structure stored in a template, making tabular data extraction 

accurate and easy no matter how long the source document is or the position of tables in a PDF 

document. 

Able2Extract Pro also has a Smart Layout Detector that continually inspects various table and 

cell properties to ensure accurate extraction with minimal formatting differences. Transferred 

borders, background colors, and fonts are faithful to the original document. 

OCR Technology 

Investintech uses advanced OCR technology that can convert even poorly scanned documents 

or electronically created files that contain damaged fonts and don’t convert well via the 

standard conversion. 

In this latest version, we’ve expanded the list of supported languages by adding support for 

Italian, Portuguese, Greek, Danish, Dutch, Norwegian, Finnish, and Swedish making it possible 

to recognize and extract the special characters common to these languages. Able2Extract 

Professional 20 now recognizes and converts special characters in twelve different languages. 
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Users can make use of the convert to Searchable PDF functionality thanks to the OCR 

technology implemented in Able2Extract. This feature can convert image-only PDF documents 

into a PDF with text that can be searched using the Search functionality. Able2Extract 

Professional will modify the PDF document with an invisible text layer for this purpose. No new 

output file will be generated. 

The process of converting scanned (image) documents in Able2Extract Professional is the same 

as any native PDF conversion process. Once you open a PDF file, the application will, by default, 

automatically detect if the file is a scanned PDF or not. You can then convert them to desired 

output format in the same manner. 

The OCR engine in Able2Extract PRO 20 is now enhanced with a recognition algorithm that 

improves the conversion quality of text and graphical elements from partially selected pages. 
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Batch Conversion 

The Batch conversion option in Able2Extract is available for both native and scanned PDF 

documents. To start, users can choose the Batch feature from the Convert tab’s Main toolbar. 

Users can add as many PDF files and directories in the Batch conversion dialogue box as they 

want. Able2Extract Professional will scan the uploaded directories and convert all the PDF files 

it finds. 

 

Users can then either browse through their computer locations to select an output folder or 

designate it as the source folder. Users can convert PDFs to any of the available conversion 
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formats: Excel, Word, PowerPoint, Publisher, AutoCAD, CSV, text, and HTML. Then lastly, 

users can choose the output to be a separate file for every PDF uploaded or a single 

document consisting of individually converted and merged PDFs. 

AI-powered templates can also be used when converting multiple PDFs to Excel and CSV. Users 

can enjoy the effectiveness of Custom Excel templates and speed of Batch conversion merged 

into one powerful feature. 

Batch Creation 

In similar fashion, users can create PDFs from multiple files thanks to a powerful Batch creator 

tool. It also comes with the ability to produce a single-file output by merging created PDFs 

before completing the conversion from 300+ printable file formats to PDF. 
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Premium Support 

Users who subscribe to Investintech’s Software Advantage Plan can enjoy additional customer 

benefits in the form of priority support via phone and email, exclusive early access to 

software updates and upgrades, and web portal account that will allow them to view the 

status of their requests and find information on new product updates and upgrades available 

for download. 

Free support is available to all Able2Extract Professional customers, but Software Advantage 

Plan subscribers who report an issue have the advantage of skipping to the front of the line and 

becoming a top priority for the members of Investintech’s support staff. 

More info on Investintech support plans here: https://www.investintech.com/support/about/ 

 

  

https://www.investintech.com/support/about/
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ABOUT INVESTINTECH.COM 

Investintech by Apryse is a leading PDF software developer, offering a business-grade desktop 

PDF converter. Many bank and finance experts, engineers, educational technologists, and other 

professionals use Investintech’s flagship product, Able2Extract Professional make PDF 

conversions simple.  

Able2Extract Professional’s cross-platform functionality and multi-language support, a 

complete set of PDF features, new and improved interface, and powerful custom conversion 

options make it a valuable tool in increasing work productivity and saving time. 

With offices in Canada and Europe, Investintech by Apryse gathers a team of devoted, skilled 

professionals who take pride in delivering the best software products and customer support to 

their software users. 

Contact Us 

Customer Support:  

 
Telephone +1 604 200 4366 

 
Hours 9 am - 6 pm EST (GMT - 5:00), Monday-Friday 

 
Email cs@investintech.com 

Technical Support:  

 
Email: Product related issues - investintech_support@apryse.com  

Site related issues - webmaster@investintech.com 

 Hours: 9 am - 6 pm EST (GMT - 5:00), Monday-Friday 

Mailing Address:  

mailto:cs@investintech.com
mailto:investintech_support@apryse.com
mailto:webmaster@investintech.com
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Mail: Investintech.com Inc. 

2399 Blake Street #125 

Denver, CO 

80205 USA 

 
Website address: https://www.investintech.com 

Connect with Investintech.com on social networks:  

Facebook: https://www.facebook.com/Able2Extract 

X (former Twitter): https://www.twitter.com/able2extract 

LinkedIn: https://www.linkedin.com/company/investintech 

YouTube: https://www.youtube.com/user/Able2Extract 

Pinterest: https://pinterest.com/Able2Extract/ 

Follow Investintech’s PDF blog for tips, tricks, document management and productivity hacks: 

https://www.investintech.com/resources/blog/  

 

https://www.investintech.com/
https://www.facebook.com/Able2Extract
https://www.twitter.com/able2extract
https://www.linkedin.com/company/investintech
https://www.youtube.com/user/Able2Extract
https://pinterest.com/Able2Extract/
https://www.investintech.com/resources/blog/
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